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Introduction to ProviderLink

Section 1 - Introduction to ProviderLink
What is ProviderLink?
Unique to the healthcare industry is our interdependence on each other. Rarely can a job be
performed without successful external communications. Before you can do your job you must
get an authorization, signature, order, medical record, referral, form, bed availability, etc. from
someone else who typically does not report to you or even work for your organization. Herein
lies the fundamental healthcare administrative problem. We are interdependent on each other
but not necessarily accountable to each other.
ProviderLink is an Internet communications tool that allows you to communicate patient
information with other healthcare facilities or professionals. Instead of being tied to a particular
fax machine or telephone extension, you can access ProviderLink anywhere you have an
Internet connection.
Any document, whether electronic or handwritten, or any other information about a patient can
be placed in the patient record and securely sent to recipients. As long as the document can be
printed to a local printer or faxed, it can be loaded into ProviderLink and attached to a patient
record.
Whether the organizations you communicate with are online with ProviderLink or not, you can
use ProviderLink to track any messages to or from them. For facilities that are online with
ProviderLink, every message you send to them appears on their computer screen. If the facility
is not yet online, you can still fax them messages and use ProviderLink's fax-back, cover sheet
to have any replies automatically routed back to the appropriate patient record. In either case,
ProviderLink streamlines all of your communications.
Whenever you are transmitting patient records, you should be concerned about security and
HIPAA compliance. ProviderLink helps customers with their HIPAA compliance. Every message
sent or received by ProviderLink is logged and date/time stamped. You can see when a
message is sent, when it was read, and who read it. All messages are patient specific, meaning
they are logged with and follow the patient record. You will always be able to see the complete
patient history in ProviderLink. The data stored in ProviderLink is secure and backed up several
times each day.

Benefits of Using ProviderLink
Each organization and each department within an organization has different communication
needs and ProviderLink has features to address them all.
Here are a few benefits current customers of different types have enjoyed since coming online
with ProviderLink:

Hospitals
a) Utilization Review
•

Less time spent faxing and on the phone
Extensive history and audit trail
b) Discharge Planning
•
•

Less time spent faxing and on the phone
• Electronically obtain prior authorizations from participating agencies
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•

Broadcast a referral (e.g., SNF, DME, HHA, etc.) with just a few mouse clicks
Referral replies are directly attached to the patient records
c) Business Office
•
•

Electronically receive requests for medical records
• Respond to requests more quickly to shorten the A/R cycle
d) Outpatient Services
•

Central fax server allows central processing of all physician orders
• Workflow management for outpatient processes
e) Outpatient Services
•

Streamline internal communication processes in one workflow

Skilled Facilities
a) Receive referrals from hospitals electronically
b) Pager notification lets you know the moment a referral arrives
c) Electronically receive and process Medicaid authorizations and prior approval
d) Broadcast referrals to assisted living, rest homes, and other facilities

DME/HME
a) Manage physician signature collections for Certificates of Medical Necessity
b) Electronically obtain Medicaid or private payor approval
c) Electronically store Medicare DMERC forms
d) Receive referrals from facilities electronically
e) Pager notification lets you know the moment a referral arrives from an online source.

Payors
a) Less time managing faxes and on the phone
b) Create online authorizations and schedule upcoming reviews
c) Copy clinical information into your other systems

Conventions Used In This Guide
•

When introducing you to a new term, the term will appear in italics.

•

Using the mouse is key to effectively using ProviderLink. When the instructions say to
click, it refers to a single click of the left mouse button. This is the main difference of
navigating and working in ProviderLink as most commands require a single click.

•

There will be times when the instructions will ask you to double-click on items. This
refers to two rapid clicks of the left mouse button. Double clicking in ProviderLink is
relatively rare.

•

The menu bar also plays a key role in navigating through ProviderLink. When you are
asked to use the menu bar, the instructions will include bold text and arrows like this:
Lookup
Facility.
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•

The instructions may call for you to type some text into a field in ProviderLink. The
text you will be asked to type will appear in a special font: This is text you need to
enter into a field.

•

If you need to press a key on your keyboard, the text on the key will appear in a bold
special font. For example, Press the Enter key.

•

When you need to click a link or a button on the screen, the link or button name will
appear in bold letters: click the Submit button.

Icons And Notes
The icons and notes used in the margins will lend you insight as to how you may best use the
instructions as they are presented.
Icon

How The Icon Is Used
The target icon points to a useful tip or hint that may help you use ProviderLink
more efficiently.
The Book icon helps to introduce an idea or concept for the first time.

How This Guide Is Organized
•

Section 1 – The Introduction To ProviderLink section gives a basic overall introduction
to ProviderLink and explains how to use this Training Guide to get the best results.

•

Section 2 – The Administering Your ProviderLink System section covers the
characteristics and roles of facility administrators and the methodology behind setting
up and maintaining your ProviderLink facility.

•

Section 3 – This E-Forms Designer Techniques section covers creating distributable
electronic forms.
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Section 2 - Administering Your ProviderLink
System
The Characteristics and Roles of the Facility Administrator
ProviderLink Facility Administrators are a vital part of the success of implementing, using, and
maintaining the ProviderLink system for your facility. The most effective Facility Administrators,
also called Super Users, usually possess the following characteristics:
•

Completely understand the organization's procedures and how ProviderLink integrates
with the day-to-day activities.

•

Computer literate and an expert in any internal clinical systems used at the facility.

•

Effective in communicating with and eager to assist co-workers.

•

Regular user (at least daily) of ProviderLink once implemented.

•

Available on-site to answer co-worker questions and address ProviderLink issues.

Besides being a ProviderLink user, the facility administrator has responsibilities in setting up,
adjusting, and maintaining the ProviderLink system for the organization. Here are some of the
roles and responsibilities of the facility administrator:
•

Assist in training new users, provide on site user support, and communicate support
issues to ProviderLink.

•

Work List and Folder Administration – add/remove work lists and folders, maintain quick
lookups, link e-forms.

•

Mailbox Administration – set up and maintain mailboxes, designate associated work
lists, and assign routing rules.

•

E-Form Administration – create and maintain e-forms.

•

Messaging Administration – create and maintain fax-only facilities, distribution lists, and
templates.

•

Patient Administration – maintain patient census, documents, and patient folders.

The ProviderLink Facility Setup Methodology
Effectively setting up ProviderLink to reflect your organization's workflows is a vital component
to successfully implementing and using the system to streamline your communications. Since
Facility Administrators are tasked with updating and maintaining the ProviderLink system for the
organization, they need an understanding of the different entities within the system and how
they are interrelated.
Most of the time, the ProviderLink system setup will resemble how the organization is set up.
Consider the example of University Hospital as outlined in the diagram below. The facility,
University Hospital, is separated into service areas such as Care Coordination, Patient Financial
Services, and Outpatient Services. Each service area may be further broken down into
departments as Care Coordination includes the Discharge Planning and Utilization Review
departments. And, within each department are the staff members.
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Because ProviderLink is designed to integrate with organizational workflows, the facility setup
will usually mirror the organization where feasible. Generally, each service area within the
organization would require a separate ProviderLink mailbox for each type of communication it
sends or receives. For example, the Care Coordination service area's Utilization Review sends
messages to insurance payors and the Discharge Planning department sends patient referrals
to post-acute facilities. Each department would benefit from having its own mailbox. Then,
depending on the department's workflow, each staff member may have his or her own work list
or caseload for which to manage the patients under his or her care.
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SW Bob Green

SW Tom Smith

SW Pat Fields

SW Ron White
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Mailboxes

Outpatient
Services

Laboratory

Radiology

Work Lists
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Setting Up Your ProviderLink Facility
Work Lists
ProviderLink is a patient-centric system. In ProviderLink, every item of work accomplished is
associated with a patient record. Whether you send a message, receive a reply, create a
document, assign a task, or process an authorization, you must associate a patient record.
Patient records are managed using work lists, or caseloads assigned to a department, team, or
individual. Patients and their associated work items can be moved from one work list to the next
as the workflow is completed. When a patient record is moved from one work list to another, all
of the associated tasks, message history, documents alerts, etc., move with it.
You will want to create work lists to help effectively manage the workflow as the patient record
moves through your facility. By observing and analyzing how each service area and department
within your organization manages its patient records, you will gain insight into how you may set
up your work lists within ProviderLink. Here is an example of an organization's workflow with
ProviderLink setup notes (in italics):
•

Upon admission, a patient is screened by the Patient Access department. The Patient
Access department will need a work list.

•

Once the patient is admitted, the patient is placed in a room on the appropriate floor and
a case manager (CM) in the Utilization Review department is tasked with completing the
initial review. Patient Access will assign the patient record to the CM's work list.

•

At some point during the admission, the Patient Financial Services department is notified
for billing purposes. Patient Financial Services will need one or more work lists to
manage billing inquiries.

•

If the patient requires post-acute care from a skilled nursing facility or home health
agency, the CM notifies the social worker (SW) from the Discharge Planning department
to begin the referral process. The CM links the patient record to the SW's work list.

•

The SW completes the documentation and hands the case to a patient resource
management assistant (PRMA) to assemble the discharge packet and poll the postacute facilities for placement. Each PRMA will require a work list.

•

The post-acute facility accepts the patient for placement, and the PRMA notifies the SW.
The PRMA links the patient record back onto the SW's work list.

•

The patient is discharged to the post-acute facility. The SW removes the patient from all
work lists once all work is complete.

By identifying these patient “touch points,” you identify the work lists needed to organize the
patient records and manage the workflow.
While it goes without saying, only Facility Administrators can perform any of the
functions listed in the “For Facility Administrators Only” section. You have facility
administrator permissions if you see the Setup option on the Main Window menu bar.

Each ProviderLink work list can have its own individual characteristics to assist the staff
members who manage it. A case manager may have specific forms to use or communicate with
specific insurance payors that no one else in the department does. You can customize the work
list to incorporate those forms and set up Quick Lookups to easily access the payor's contact
information.
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The Quick Lookup allows a user to quickly add a linked mailbox to a View Patient
Information screen without having to search for each mailbox. This is useful for staff
members who frequently communicate with the same contacts, like a case manager who
frequently communicates with the same insurance payors.

Depending on your organization's composition and work flows, patients may not be assigned to
a case manager or social worker but be placed in a pool for the next available staff member to
process. If patient records are to be processed in a “first come, first serve” manner, you may set
up a work list to collect the patient records to be processed. Then, each staff member may use
the “Next” button on the Main Window menu bar to pull in the next available patient record for
processing.
To Create A Work List:
1. From the Main Window menu bar, click Setup to enter the Facility Administrator console,
and then click Work Lists. The View Work Lists screen appears.
2. From the menu bar, click New. The Add/Edit Work List Information screen appears.
3. Enter a unique new Work List Name. Each work list must have its own name.
Because ProviderLink sorts work lists alphabetically, use a naming convention to
organize your work lists. When naming work lists for staff members with similar job
functions (e.g., social workers), it is recommended to prefix the staff member's name
with an abbreviation (e.g., SW Sue Green).

4. If you wish to use the Next button to pull patient records out in a first come, first serve
manner, use the Select A Work List drop-down list to choose the work list that holds the
collection of patient records.
5. If the staff members using this work list will frequently send messages to the same
several communication partners, you may specify the mailboxes in the Quick Lookups
list. Click the Search button to find the mailboxes using the search techniques as
outlined in the ProviderLink User Training Manual.
6. When you have finished creating the work list, click Save to return to the View Work
Lists screen.

Managing E-Forms For Your Work Lists
Any form that a ProviderLink customer facility builds enters into the ProviderLink E-Forms library
and can be made available for any ProviderLink customer to use. This enables you to publish
forms for your outside communication partners to use to send you information in a format you
specify. As an example, a hospital may produce an outpatient procedure order form and the
surrounding physician clinics can use that form to send outpatient orders online to the hospital.
Each staff member, team, or department will have different functions in processing patient
records and, in turn, require different forms to be filled out, signed, and transmitted. A social
worker may need Medicaid forms for planning patient discharges while a case manager may
need utilization review worksheets. To this end, ProviderLink e-forms are made available to staff
members at the work list level and can be either used exclusively for a particular work list or
shared across several work lists.
When you first create a work list, you will also need to determine which E-Forms should be
associated with the work list. To designate E-Forms for a work list, see steps below.
To Designate E-Forms For A Work List:
1. From the View Work Lists screen menu bar in the Facility Administrator console, click
the Work List Name link to access the Edit Work List screen.
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2. On the menu bar, click E-Forms to view the Linked Forms screen for that work list.
3. To remove a form from the work list, click the Remove button at the right of the form
name.
4. To add a form to the work list, click Add on the menu bar. The Link Forms screen
appears, displaying the forms in the ProviderLink e-forms library.
5. Find the form or forms you wish to add to the work list by searching via the Facility who
created the form, the Form Name, or the Form Description.
6. Click the respective check box to select the form(s).
7. When you have selected the forms to add to the work list, click Save on the menu bar to
save your changes. You will return to the Linked Forms screen with your newly selected
forms added to the list.
By default, ProviderLink lists the forms on the Link Forms screen alphabetically by the
form Name. It may help you find the form or forms you are looking for by sorting the
forms by the owner, or facility that created the form. Click the Owner column header to
sort the list alphabetically by facility name.

Mailboxes
Each ProviderLink customer broadcasts customized online mailboxes. Mailboxes are entry
points for others to use when initiating communications with an online organization.
The mailboxes and instructions you set up and broadcast are your customized directory to the
world. Mailboxes provide many benefits for both you and for those who want to communicate
with you online. If set up correctly, your customized mailboxes and accompanying instructions
can significantly reduce the number of incoming requests for information and call routing.
Careful planning goes into effectively using mailboxes to route messages to the right workers in
your organization. First, outline all of the reasons someone might want to contact your
organization. For example, they might want to ask for a particular type of authorization, send
you a referral, request a signature, access a proprietary tool you offer, or order an outpatient
procedure.
Then, list which groups or individuals should receive each type of communication and how
these communications are assigned for follow up. Some types of communications are routed by
facility name to a particular person or to a queue for manual distribution to the next available
member of a work team. Other types of inquiries might be routed to a subcontractor agency to
evaluate for you.
Once you have determined the mailboxes you will need to name your mailboxes and create
your mailbox instructions. You can name your mailboxes anything you want but keep in mind
that mailboxes are designed for people who want to initiate communications with you. Name
your mailboxes something that outsiders to your organization would understand. Ask yourself
the question; "If I wanted to send a message or request, would I know which mailbox to select
based on this list of mailbox names?" Here are some mailbox name examples others have
used:
•

Inpatient Authorization Requests

•

Out Patient Behavioral Services

•

Pre-auth Form Submissions

•

Medical Record Requests

•

HMO Plan Certifications for NC and VA Providers
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Decide which of these mailboxes you will accept ProviderLink communications through. A
mailbox can route incoming messages to any workflow based on customizable routing rules or it
can simply give instructions on how to contact you manually by listing correct phone or fax
number. Mailboxes can also route users to your proprietary tools or to a subcontractor you use
to manage a certain type of request. The main thing is to make sure everyone knows how you
want to be communicated with concerning each type of inquiry. This directory will mirror how
your organization chooses to do business. It also affords you a quick and easy way to inform
others whenever these processes or procedures change.
Create your instruction screens explaining in more detail what each mailbox is for and how it will
be routed. If relevant, include procedural instructions, information requirements, and a number
for people to call if they do not understand what to do. You can also include policy statements
and disclaimers here. Some payors specifically list types of requests that should not be sent to a
particular mailbox. It is often a good practice to list steps in a 1,2,3 format. You can even use
this screen to set other's expectations concerning your organization's average response times
and exceptions policy.
Make sure that each work list you use is associated with the mailbox it services. Although a new
incoming message can be read from any work list the patient is in, the message will only be
marked "read" once someone logged into a work list associated with the receiving mailbox
reads the message. This is how ProviderLink makes sure that new incoming messages relating
to a patient in multiple work lists do not get removed from the unread message queue before
being seen by someone working with the mailbox where the message was sent. Messages can
be manually marked as read from any work list associated with any mailbox if the "mark as
read" function on the message is used, but they will not default to a read status until the
appropriate user reads the message from a work list associated with the mailbox receiving the
message.
To Set Up A Mailbox:
1. From the Facility Administrator console menu bar, click Mailboxes. The View Mailboxes
screen appears, listing your facility's existing mailboxes.
2. To create a new mailbox, click New on the menu bar. The Add/Edit Mailbox screen
appears.
3. Using the guidelines listed above, enter a Mailbox Name.
4. Select the appropriate check box options for how you would like this mailbox to be used.
a. Mailbox can be searched - This option allows users searching for your facility to
find this mailbox.
b. Mailbox is internal only - Checking this box will enable only users at your facility to
send a message to this mailbox. This mailbox will not be visible to other facilities.
c. Automatically add attached faxes to patient documents - By default, any faxes
sent to your facility are not automatically added to a patient's record (they may be
added manually). If this option is selected, any fax attachment sent with a message
to your facility will be automatically added to the respective patient record.
d. Messages can be sent to this mailbox - Checking this option will enable a user to
send a message to this mailbox.
e. Force routing rules for this mailbox - Routing rules are discussed below. Choose
this setting if you want messages with certain characteristics (i.e. from a specific
facility, with a certain word in the subject, or about a specific patient) to always be

9

Administering Your ProviderLink System
routed to a particular work list regardless of any other work lists on which the patient
record already appears.
f.

Edit Information Request Fax Cover Page - Check boxes to remove the following
information from Fax Cover Pages sent out from this mailbox.
i.

- Remove Patient Information

ii. - Remove Fax Number
iii. - Removed User Phone Number
iv. - Remove User Name
g. Edit Bar-Coded Fax Back Cover Page - Check boxes to remove the following
information from Fax Back Cover Pages sent out from this mailbox.
i.

- Remove Patient Information

ii. - Removed User Phone Number
iii. - Remove User Name
You can use an inactive mailbox (i.e., one that is searchable but cannot receive
messages) to publish instructions for sending messages to your facility. Simply choose
only the option where the “Mailbox can be searched” and enter the mailbox instructions.

Routing Rules
Messages and requests can be sent to your organization through active mailboxes. To make
sure these messages get routed to the right place, use ProviderLink automatic routing rules
when possible. Each mailbox can have its own routing table. Incoming messages can be routed
to a specific intake work list for manual routing to other work lists. They can also be routed
automatically to one of your ProviderLink work lists based on the sending facility's name or
other attributes. Some smaller facilities may use one mailbox for all communications while larger
systems and payors may have dozens of mailboxes. These are very easy to set up and
maintain.
To Set Up And Manage Routing Rules For A Mailbox:
1. From the Add/Edit Mailbox screen of a saved mailbox, click Routing Rules on the menu
bar to view the View Rules screen for that mailbox. This will give you a list of all existing
Routing Rules for the mailbox.
2. To add a new Routing Rule, click New Rule on the View Rules menu bar.
3. Rule Description field: Enter an appropriate description of the routing rule.
4. Conditions section: Set the following conditions the message must meet for the routing
rule to take effect.
a. Select a Condition field: Select one of the following conditions.
i.

All of these conditions are true - If you have multiple rules and all conditions must
exist for the action to occur, select All of these conditions are true.
Note: If this condition is selected, the screen expands and displays additional
“Add Condition” fields. Proceed to 4b.

ii. Any of these conditions are true - If you have multiple rules and only one of the
conditions must exist for the action to occur, select Any of these conditions are
true.
Note: If this condition is selected, the screen expands and displays additional
“Add Condition” fields. Proceed to 4b.
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iii. Always - If this rule is always true, select Always.
Note: There are NO additional fields to select. Proceed to the Actions section.
b. Add Condition button: Click the Add Condition button to add an additional condition
to the rule. There is no limit to the number of conditions you can add to a routing rule.
c. Select A Field - Select a field from the drop-down list that will hold the criteria for
which the message will be routed (e.g., Patient Name, From Facility Name, etc.).
d. Comparison fields: Select one of the following conditions from the drop-down list.
i.

Equals - The value in the incoming message's field selected above in the Select
A Condition drop-down list must equal the value entered below in the Value
field (step 5).

ii. Starts With - The specified message attribute value must begin with the value
entered in the Value field.
iii. Contains - The specified message attribute must include the value entered in the
Value field.
iv. Not Equal To - The specified message attribute must not equal the value entered
in the Value field.
5. Value field - Enter the value in the blank text box to which the field will be compared.
6. Remove button - Clicking this button will remove the specified condition from the routing
rule.
7. Actions section: Define the actions that should occur when a message meets the
condition(s) listed above.
a. Add Action button - Click this button to add an addition action to the rule. If the
message meets the conditions, the system will perform all of the specified actions.
b. Select An Action drop-down list: Select one of the following actions.
c. Add Patient to Work List: Patient referenced in the incoming message is added to the
work list(s) specified in the "Select a Work List" field (displayed in the 2nd column)
based on conditions selected in the Conditions section.
Note: Only work lists assigned to this mailbox are displayed in the "-Select a Work
List-" drop-down list.
i.

Select a Work List drop-down list - Select the work list on which to place the
patient record associated with the message.

d. Forward Message and Attachments: This allows the system to forward all messages
and attachments to the selected facility (displayed in the second column) based on
conditions selected in the “Conditions” section.
i.

Click the Search button to use the Facility Search feature to select a facility.

e. Clear button - Click to remove the selected facility, if not correct.
f.

Remove button - Click to remove the specified action from the routing rule.

g. Mark Messages Read check box - Selecting this option will, when the patient record
is added to the specified work list, mark the message as read (i.e., it will not appear
as an unread message).
h. Link Originator to Patient check box - Click the check box to automatically link the
originator (the facility that sent the fax) to a patient record when using the fax splitter
feature in your facility's "default incoming fax folder." When moving a fax from the
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"default incoming fax folder", if "Link Originator To Patient" is checked, a quick link
will be created on the patient record in the Linked Mailboxes section on the View
Patient Information screen.
8. When you are finished setting the routing rule Conditions and Actions, click Save to
create the routing rule. You will return to the View Rules screen for the chosen mailbox.

User Administration
NOTE: If you log in via the Covisint Portal, this section DOES NOT apply.
There are two types of users in ProviderLink: users and Facility Administrators. Standard users
may create and manage patient records, create and access documents, electronically sign
documents, send and receive messages, create and process tasks, link patients to and remove
patients from work lists, view message history and audit trails, and respond to alerts.
As a Facility Administrator, you will control who has access to the protected healthcare
information (PHI) stored in ProviderLink. Each staff member that will access ProviderLink will
require his or her own user account, which contains all of the information used to identify the
user and provider access to the system. Before a user can begin using ProviderLink, a Facility
Administrator must create a user account and provide the login information to the user.

IMPORTANT - Information Security And Protecting You r Data
Information security is a business issue, not just a technology issue. The reason organizations
want to protect information should be for sound business purposes. Organizational knowledge
and data are arguably the most important assets of any facility. Corporations must ensure the
confidentiality, integrity, and availability of their data.
While it should go without saying, your protected healthcare information (PHI) is only as secure
as your least security-conscious user keeps it. As a Facility Administrator, you are responsible
for making sure your users are adhering to HIPAA regulations and keeping PHI secure. To that
end, security is everyone's responsibility.
One of the first steps in ensuring your facility maintains secure PHI within ProviderLink is to
designate at least two active Facility Administrators. This ensures internal accountability within
your facility and also provides more supervision of your users.
Creating User Accounts
You may also choose to have ProviderLink send the user a pager text message or email
message when an unread message arrives on designated work lists. This is useful for users
who may not continuously monitor ProviderLink and would need to be notified when incoming
messages arrive.
ProviderLink features the ability for a user to access patient records in more than one facility
within the same domain. You may use separate facilities to help manage distinctly different
workflows, particularly in larger organizations. When using multiple facilities under the same
domain, you may choose to allow users to sign into more than one facility using the same user
account.
To Manage User Roles:
1. From the Main Window, click Setup > Users to display the View Users screen and list
your facility's existing users.
2. To search for a specific user, enter the user's last name in the Last Name field and click
Search. The search results display at the bottom of the screen.
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3. To change the user account settings, click the user's User Name to access the Add/Edit
User Information screen.
4. In the Facilities In Domain section, if you have one facility, the Associate User to the
Facility? check box will be selected for you. If there is more than one facility listed,
associate the user to the appropriate facility(ies) by clicking the check boxes.
5. For each facility selected, you will need to designate the Default Mailbox to be used
when the user sends a message. Select the mailbox from the drop-down list.
6. If the user wishes to be notified by email when an incoming message arrives, click the
Enable Email Notification check box. Additional fields appear.
a. From the All Available Work Lists list box, select the work list for which the user
would like to be notified when an incoming message arrives and click the Add
button. The work list is added to the Work Lists to Watch list box.
b. To remove a work list from the Work Lists to Watch list box, select the work list to
be removed and click the Remove button.
7. To designate the user as a Facility Administrator, which gives the user access to the
Setup menu: click the + next to Special Roles, and click the Facility Administrator
check box.
8. When you have finished setting up the user account, click Save.
Managing A User's Account Status
Any user account within ProviderLink will fall into one of two status categories:
•

Active: Active users have valid user accounts and are able to launch ProviderLink from
the Covisint Connection and Administration (CCA) site to manage patient records.

•

Inactive: When a user should no longer be allowed to log into ProviderLink, their user
account should be inactivated.

To Change The Status Of A User Account:
1. From the Facility Administrator console menu bar, click Users. The View Users screen
appears with the users listed and their status displayed.
2. Change the status for the user account
a. To inactivate a user account so that the user may not access ProviderLink, click the
Inactive button.
b. To activate a user account that was inactive, click the Activate button.
c. To unsuspend a user account that has been suspended, click the Unsuspend
button.
To Reset A User's Password:
Users can reset their passwords by following these steps:
1. From the Covisint login screen, the user clicks Forgot your password? The screen
expands to display a User ID field.
2. User enters their username, and clicks Submit.
3. In the Challenge field, they enter the answer to the challenge question. Click Submit.
4. The first four characters of the new password will display on the user’s screen and
remaining four characters will be emailed to the user.
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If a user forgets their username, it can be retrieved as follows:
5. From the Covisint login screen, click Forgot your User ID? The screen expands to
display an Email address field.
6. The user enters their email address, and the user ID will be emailed to the user.

Working With Templates
Many times when sending similar types of faxes to other facilities, staff members would write the
same “canned” statement on the fax cover page. When sending these faxes, many people
would set up pre-printed fax cover pages with the basic “Please call XXX-XXXX with any
questions, thank you for your attention” message already included. In the same way, users may
use templates while sending messages through ProviderLink to add those types of statements
to the body of a message.
Templates can be set up for any type of message the users may send whether the recipient is
online with ProviderLink or a fax-only contact. Using templates can help standardize messages
within your facility to foster consistency among your staff members. Once added to an outgoing
message, template text can be added to or changed by the user to customize the message.
To Create A Message Template:
1. From the Facility Administrator console menu bar, click Templates. The Templates
screen appears.
2. From the menu bar, click New. The Add/Edit Template Information screen appears.
3. Enter the Template Name to identify the template. This name will appear in the
Templates drop-down menu when users create messages.
4. Enter an appropriate Template Description.
5. If needed, enter subject text to be displayed in the Message Subject line, on the Create
Message screen.
a. You can check the box marked Overwrite Current Subject if you want the
template’s subject to overwrite any pre-existing subject that appears in the message.
6. Enter your template text in the Text to appear field. You may use the underline
character (_) to create “blanks” for the user to fill in, if desired.
7. When you are satisfied with the template, click Save to save your changes and return to
the Templates screen.
To Edit An Existing Template:
1. From the Templates screen, click the template Name link to access the Add/Edit
Template Information screen.
2. Make the desired changes to the Template Name, Template Description, or Text to
Appear.
3. Click Save to save your changes and return to the Templates screen.
To Delete A Template:
1. From the Templates screen, click the template Name link to access the Add/Edit
Template Information screen for the template you wish to delete.
2. From the menu bar, click Delete.
3. ProviderLink will ask you to confirm that you wish to delete the template. Click the OK
button to delete the template and return to the Templates screen.
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Managing Overdue Items Settings
To help promote accountability and effectiveness among your staff members, ProviderLink will
alert them when items may be overlooked. There are several reasons alerts could be triggered:
•

A task is not accomplished or deleted by the assigned due date.

•

An incoming message is left unread for a specified period of time.

•

A sender of a message to your facility requested a reply and the request has not
been fulfilled within the specified period of time.

•

A staff member in your facility sends a message, requests a reply, and the recipient
has not replied within the specified time period.

Overdue Items settings are set at the facility level, meaning all users for all work lists will share
the same settings. By default, ProviderLink will turn on all triggers and set the delay to the
default of 24 hours. Facility Administrators may choose to alter these settings at any time.
To Change The Overdue Items Trigger Settings:
1. From the Facility Administrator console menu bar, click Overdue Items. The Overdue
Items screen appears.
2. To turn off the alert notification for an event trigger, click to remove the check mark from
the On check box.
3. To change the time delay for the alert to be triggered, change the value in the Delay
Hours field. You must enter a whole number between 0 and 999 hours. The default
value is 24 hours.
4. When you have finished making changes, click Save to return to the Facility
Administrator console.

Using The “My Procedure” Feature
ProviderLink's “My Procedures” feature allows Facility Administrators to include additional user
documentation within the system itself as a quick reference guide. This makes the instructions
readily available to each user without forcing the user to carry the documentation.
The “My Procedures” feature is set at the facility level, meaning every user within the facility can
access the “My Procedures” feature from the Main Window menu bar. If you decide to use the
“My Procedures” feature to add instructions for more than one department or service area, be
sure to clearly separate or segment the instructions so that each department may easily find
and use the instructions.
To Set Up The “My Procedures” Instructions:
1. From the Facility Administrator console menu bar, click Customizations
Procedures. The Add/Edit My Procedures screen appears.

My

2. Enter the instructions in the text area provided.
3. When you have finished, click Save to save your changes and return to the View Main
Facility Information screen.

Getting The Most From Distribution Lists
One of the most convenient ProviderLink features is the ability to transmit messages to any
number of recipients at one time using distribution lists. A distribution list is a collection of
mailboxes (online, fax-only, or a combination of both) used to broadcast a message to all
mailboxes in the collection at one time.
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As a facility administrator, you can greatly improve the users' efficiency by creating distribution
lists for the most common applications. For example, if the social workers frequently send
referrals to home health agencies in a three county area, they would be able to do this very
quickly using a distribution list that contained those agencies. When a user sends a message
using a distribution list to 30 area skilled nursing facilities, it is much easier and more efficient
than searching for and selecting each of the 30 mailboxes. Also, when a utilization manager
sends service authorization requests to a specific mailbox, a distribution list would help to
quickly address the message without having to search for the mailbox each time.
When you create a distribution list, it becomes immediately available to all users in your facility.
To Create A Distribution List:
1. From the Facility Administrator console menu bar, click Customizations > Distribution
Lists. The View Distribution Lists screen appears.
2. From the menu bar, click New to access the Add/Edit Distribution List screen.
3. Enter a descriptive name in the Distribution List Name field. This will be the list entry
that will appear in the Select Recipients drop-down list when the user sends a
message.
4. Click Save.
5. Click the name of the Distribution List you created.
6. Add the recipient mailboxes to be used in the distribution list.
a. Click the Add Recipient button. The Facility Search pop-up window appears.
b. Enter the search criteria and click Search.
c. When the search results appear, select the mailboxes you wish to add to the list.
i.

Click the plus (+) sign to the left of the facility name to view the available
mailboxes.

ii. Click the check box to select each mailbox you wish to add.
iii. When you have finished selecting mailboxes, click Save on the menu bar. The
system will add the mailboxes you selected to the distribution list and return you
to the Add/Edit Distribution List screen.
iv. Repeat Steps 6.a. through 6.c. as necessary until you have added all of the
desired mailboxes to the distribution list.
d. To remove a mailbox from the distribution list, click the checkbox next to the Mailbox
name, and click Remove Selected.
7. When you are satisfied with the mailboxes in the distribution list, click Save to save your
changes and return to the View Distribution Lists screen.
The distribution lists will appear in the Select Recipients drop-down list in alphabetical
order. Be consistent in naming your distribution lists so that your users will locate the
distribution list they need quickly.

Setting Up Message References
The Message Reference is a drop-down field that appears on the individual View Patient
Information screen for each patient. Primarily, the Message Reference is used in conjunction
with routing rules for incoming messages to make sure incoming messages that meet certain
criteria are routed to the proper work list (see “Error! Reference source not found.). When a
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message arrives through one of your facility's mailboxes, it can be placed automatically in the
appropriate work list based on a value in the Message Reference field.
For example, an insurance payor facility has case managers assigned to provide authorizations
for requests submitted by several providers. When the provider creates the patient record, she
selects the originator from whom she is requesting authorization and types this in the Message
Reference field on the View Patient Information screen. Then, when she sends a message
regarding the patient, the Message Reference is added to the message and sent to the payor's
mailbox. When the message arrives, a routing rule recognizes the originator noted in the
Message Reference field and routes the message to the work list of the case manager assigned
to the specified service. Using the Message Reference field helps to ensure messages are
routed to the appropriate work list by eliminating any guesswork when sending messages.
The message originator must select the Message Reference on the individual patient records
before sending messages. The message recipient must have routing rules configured to route
the messages to the respective work lists. Facility Administrators in each facility must determine
what Message Reference values to use for the different services, purposes, or situations for
sending messages.
The Message Reference can also be used to include your organization's provider number or
other account identifier with each message to your communication partners.
To Configure The Message Reference Values:
1. From the Facility Administrator console menu bar, click Customizations
References. The Add/Remove Message Reference screen appears.

Message

a. To add a Message Reference:
i.

Enter the message reference in the Add Message Reference text box and click
Add. The reference now displays the Message Reference text box.

b. To remove a Message Reference from the list:
i.

From the Add/Remove Message Reference screen, select the reference in the
Message Reference text area and click Remove. Your value is removed from the
list of Message References.

Using Folders To Manage Documents
Ordinarily, documents in ProviderLink will be associated with a patient record. This way, patient
documentation stays with the record regardless of which user or work list is linked to the patient.
There may be times where you will need to store documents, such as incoming faxes, without a
ProviderLink patient record. Folders allow you to store documents without linking the document
to a patient record.
When setting up folders, you may choose from two folder types: 1) message, 2) folder. The
biggest difference between the folder types is what information the system requires before
storing documents. Message folders require the user, when a message arrives, to specify the
message originator, recipient, and associated patient record before storing the document. Most
facilities choose to configure their incoming fax folders as message folders.
Messages received in folders may be moved to another folder, linked to a patient record, or
both. Users may specify other pertinent information about the message using metadata.
Metadata, defined literally, is “data about data.” In other words, metadata allows users to record
other information about the incoming message such as the type, date, or status. The metadata,
once recorded with the message, can allow the user to find the document in question more
easily.
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ProviderLink has recently added the feature that allows folders to be created inside of the
patients’ documents listing. This will allow you to better organize and keep track of documents
that are saved within the patient. When patient folders are setup, they will get created for all
patients within a facility. This is something to be aware of when setting up the patient folders.
ProviderLink also features a trash folder which holds copies of each document that is routed or
deleted from any patient record in your facility. Facility administrators can locate documents in
the trash folder and either move them (i.e., to a patient record or another folder) or delete them
permanently.
To Set Up A Facility Folder:
1. From the Facility Administrator console menu bar, click Folders
View Folder List screen appears.

Facility Folder. The

2. To create a new folder, click New from the menu bar. The Add Folder screen appears.
3. Enter a Folder Name. This name will appear in the Choose Work List View drop-down
list.
4. Enter the Folder Description.
5. Choose which type of folder you wish to create and select the corresponding Document
View Type from the drop-down list.
a. Folders: The “Folder” folder type allows you to store documents without requiring you
to link them with patient records. This workflow allows you to move documents from
folder to folder without moving a patient record. One limitation of documents that are
not linked to patient records is that they may not be attached to messages or sent
using ProviderLink.
b. Messages: The “Message” folder type is the most commonly used. Considering that
an incoming fax is a type of message from an outside sender to someone in your
facility, this workflow is best completed using a Message folder type. This type
enables you to add the fax document to a patient record and route the incoming fax
message to one of your facility's mailboxes and its associated work list.
6. Click the Make Visible check box to allow users to see and use the folder. Otherwise,
the folder will be hidden from users.
7. Click Is Fax Folder if you want the folder designated as a facility fax folder.
When you delete documents from patient records, they immediately go into the Trash
folder. You can make the Trash folder visible and then access it from the Main Window
to more easily recover documents.

8. Once you are satisfied with your new folder settings, click Save to save your changes
and create the folder. ProviderLink creates the folder and returns you to the View Folder
List screen.
9. To make changes to your folder settings, click the folder Name link to access the Edit
Folder Information screen.
To Set Up A Patient Folder:
1. From the Facility Administrator console menu bar, click Folders
Add Patient Folders screen appears.

Patient Folder. The

2. To add a folder to a patient, enter a Name. This name will appear in the patients’
Documents List.
3. Enter the Description.
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4. If you need to create more folders than five, you can click the More button to add
additional folder rows.
5. Once you are satisfied with your new folder settings, click Save to save your changes.

Adding And Maintaining A Fax-Only Facility
It takes a facility administrator to add fax-only facilities to their ProviderLink system to help
prevent users from creating duplicate facilities. You may create fax-only facilities from within the
message recipient search results or from the Main Window.
When creating fax-only facilities, there are a few fields that are required. However, the more
information you can provide when creating the facility, the easier it will be for the users to find
and use the facility.
Once a facility administrator creates a fax only facility, any user can create a contact mailbox to
add a fax number to the facility. However, only a facility administrator may delete fax-only
facilities or contact mailboxes. This is generally done when a facility, one that your organization
formerly communicated with via fax, comes online with ProviderLink and you need to remove
the fax-only contact so the users will use the facility's online mailbox.
To Create A Fax-Only Facility:
1. From the Main Window, click New
screen appears.

Facility. The Add/Edit Fax Facility Information

2. Enter the name of the organization in the Fax Facility Name field. Keep in mind, this is
the name a user will search for when sending messages.
3. Enter the office phone number (NOT THE FAX NUMBER) in the Main Phone Number
field.
4. Enter the City and Zip Code in their respective fields.
5. Choose a State or Province from the drop-down list, and then choose the County, if
known.
6. From the Facility Type list box, choose the type that describes the facility and click the
Select button and the facility type will appear in the Selected Facility Type list box. Keep
in mind that more than one facility type may apply.
7. When you are satisfied with the information you have entered, click Save to create the
facility. The Select Facility screen displays.
8. View the Select Facility screen, and add contact mailboxes.
9. From the menu bar, click Add Contact. The Add/Edit Contact Mailbox screen appears.
Note the required fields on this screen – First Name and Fax #. You must enter at least
the fax number and a name for the mailbox, though it is desirable to enter as much
information as you have in the other fields, especially the Description and Mailbox
Instruction fields, to help users find and use the mailbox.
In the First Name field, it is usually recommended to enter the department or section for
the fax number as opposed to a proper name. For example, if you enter “Mary” for a fax
number and, later, Mary leaves her position, your users may become confused as to
which fax contact to use and may create multiple entries for the same contact. It is
usually better to use more impersonal names like “Main” or “Admissions” instead.

a. To help answer your users' questions about how to use the contact mailbox, enter
some mailbox instructions to include the fax number itself, what types of messages
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or documents the fax contact will accept, a phone number for the facility, and any
other information you feel will be helpful.
b. Once you have entered the mailbox information, click Save to save the contact. You
will return to the Select Facility screen where you may add more contacts, edit the
facility information, delete the facility, and navigate to a different part of the system.
To Edit A Fax-Only Facility:
1. To edit a fax-only facility, you must first search for and find the facility. From the Main
Window menu bar, click Lookup
Facility to display the Facility Search screen.
2. Enter your search criteria to find the facility you wish to edit and click Search. The search
results appear on the bottom of the screen
3. Click the Facility Name link of the facility you wish to change. The Select Facility screen
appears.
4. On the menu bar, click Edit Facility to view the Add/Edit Fax Facility Information screen.
5. Make the necessary changes to the facility information then click Save to save your
changes.
To Delete A Fax-Only Facility:
1. To delete a fax-only facility, you must first search for and find the facility. From the Main
Window menu bar, click Lookup
Facility to bring up the Facility Search screen.
2. Enter your search criteria to find the facility you wish to edit and click Search.
3. Once the search results appears, click the Facility Name link of the facility you wish to
delete. The Select Facility screen appears.
4. From the menu bar, click Delete Facility. ProviderLink will ask you if you are sure you
want to delete the facility. Click the Yes button to delete the facility and return to the Main
Window.
Note: If you do not want to delete the facility, use the breadcrumb trail to navigate back to
another page to cancel the deletion.
Once you delete a fax-only facility, you will not be able to use the same facility name in
an attempt to recreate the facility. Because ProviderLink's 100% accurate message
history feature lists the originator and recipient for every message sent, deleting a faxonly facility does not remove it from ProviderLink completely but simply prevents it from
being accessed. When you attempt to create a fax-only facility using the name of a
previously deleted facility, ProviderLink will display an error message and you will need
to change the facility name to create the facility.

20

E-Forms Designer Techniques

Section 3 - E-Forms Designer Techniques
Overview
The ProviderLink E-Forms Designer is an easy to use design tool for creating freely distributable
electronic forms. Using e-forms can be much easier for your users than completing paper forms
or using database or spreadsheet programs so your users do not need special skills to get the
job done. You users can complete and send e-forms from within the ProviderLink system
instead of having to maintain and transmit paper forms.

Advantages Of Using E-Forms Vs. Paper Forms
•

Reduces manual entry of data since fields can be auto populated using data from the
patient record.

•

No more duplicate entry of data.

•

More accurate data entry with fewer errors.

•

Information is legible.

•

E-Forms can validate data entry and ensure required fields are completed.

•

Easy to sign electronically, print for signature, or send for signature.

•

You can produce multiple copies without carbonless paper or copier.

•

No need to maintain stores of blank forms in each department that uses the forms.

•

Forms are easily maintained and updated as needed.

•

Eliminate form production and printing costs.

•

Data entered into e-forms is secure which assists in HIPAA compliance.

The ProviderLink Forms Designer
The Forms Designer in ProviderLink is a high-level development tool used to create electronic
forms for common paper-oriented tasks. The Forms Designer does not require programming
experience yet it allows you to create fairly complex forms that will meet your needs in most
situations.

Features Of The Forms Designer
•

Data Field Types
You will create data fields to specify the data you will enter into and store with your form.
Each data field will have a Field Label, which will be the name for the field and will
appear on the form with the field. After you enter your field's name, you will need to
choose the field Type and corresponding properties to specify how the field will be used
and what type of data the field will contain.
Before you begin creating your data fields, you should have an understanding of the
different data field types available in the Forms Designer and how each type may be
used. There are eight basic data field types as shown in the following table, and some
types have several options:
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Field Type

Max Width (in
characters)

Can Auto
populate?

Description/Used For

Text

1 to 64, depending
on column layout*

Yes

Text or combinations of text and
numbers, such as addresses, or
formatted data such as Social Security
Number., Medicare Number, numbers
only, letters only, Zip Code, US Phone
Number, UPIN, and regular
expression.

Textarea

1 to 64 with multiple
lines, depending on
column layout*

No

Flowing text field for writing lengthy
text and numbers, such as notes or
descriptions.

Date

N/A

Yes

Storing dates.

Yes/No

N/A

No

Fields that will contain only one of two
values: Yes or No

Select From List
(Drop-down)

N/A

Check box

N/A

Radio (Select One)

N/A

Instruction Text

N/A

No, but can set a Allows you to choose a value from a
default option
list using a drop-down box.
No

Similar to a Yes/No where user can
select if a value.

No, but can set a Gives the user a group of options from
default option
which one choice may be made.
No

Used for written instructions or
guidelines; no data entry possible.

* Max width will vary with the column layout chosen (see the Column Layout options in
the section below). For a column layout of one column, a text or text area field may
contain 64 characters.
•

Data Sections
You can use data sections to organize and lay out your e-form. Each e-form must have
at least one data section (to include a Data Section Name), but most forms will have
more than one. You can even incorporate some basic logic to determine when a data
section should be visible. For example, depending on how a user answers one of the
questions on the form, you may have some follow up questions. In this case, you would
use the Depends On field, as pictured below, to cause the data section to appear based
on another field's value.
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In each data section, you can specify the Column Layout from six choices. These
layouts help to organize and format your form both for online and printed use.

After you name your data section and choose a layout, you will specify which data fields
to include in the data section. Each field may only be used once in each data section, but
a field may be used in more than one data section. This allows you to reuse commonly
used fields.
•

Signatures Area
The Forms Designer allows you to designate signature areas at the bottom of your eforms. Each signature area needs a field label (i.e., usually the title or name of the
individual signing the form), the option of including a date field, and the ability to auto
populate the signature field with the user's name or electronic signature.

•

Online and PDF (print) Previews
It can be exceedingly frustrating to create an e-form and, when you view it online or
printed, it does not look anything like you intended. To prevent any such surprises, the
Forms Designer features Preview Form and Preview PDF buttons to see what the eform will look like online and printed, respectively.

Creating An E-Form Using The ProviderLink Forms Designer
Like the development of any application, the process of creating an e-form can also be divided
into different life-cycle steps. This can help to publish the form effectively, and the standards
and procedures can be adopted to achieve maximum quality.
This tutorial explains the steps of e-forms design and development and can be used as a
guideline when creating your e-forms. You may not need to follow each step within each phase
of the development life cycle for every e-form you create, though a reasonably thorough
understanding of the instructions described below will give you the best chance for success in
creating, implementing, and using your e-forms.

Requirements Analysis And Definition Phase
Once you decide to create an e-form, you will want to meet with the key people who will use it to
determine the full scope of requirements. During the requirement analysis phase you define the
target audience of the form, the business expectations, the technical constraints, and the user's
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goals. You interact with your communication partners to have an understanding of the form's
purpose and to know which resources you need to build it. Usually, you will prepare different
scenarios. A scenario is a hypothetical representation of how a specific (i.e., imaginary) person
will interact with the e-form during their typical day. This allows you to continue to the next
phase of the development.
Some Factors To Consider During This Development Phase:
•
Which facility or organization produces or owns the form in question?
Replacing a paper form with an e-form requires the permission and coordination of the
organization that owns the form.
•

What other facilities use the form?
Each facility or organization that uses the paper form should be notified of any changes
to the form and its associated processing.

•

Is the form sent to internal departments only, or is it transmitted or sent to other
organizations?
Like sharing the form with other facilities, you will want to keep your internal
communication partners updated on any changes to the form.

•

Where does the form need to be stored or archived?
Does a copy need to be printed and given to another party, stored with a patient's paper
record, or will all copies of the form remain online?

Design Phase
At this point, you should have enough information to begin defining your form's design using the
specifications and requirements you learned during the previous phase. This phase in the
development life cycle is generally the longest in terms of time spent planning, roughing out,
and designing your e-form.
There are several ways to go about designing the e-form layout. A primitive, yet effective, way is
to rough your form out on paper by drawing a diagram. By laying out the e-form on graph paper
you can get a good idea of its structure, design, and functionality. Your e-form diagram should
give you a good idea of the data fields you will need to create and the data sections you will use
to organize your fields. These terms will be explained in detail later in this section.
During the design of the form, you should keep in mind the form will have two different views:
the online view where the users will fill in the data; and the hard copy view where the form will
be printed or faxed. While these views will be very similar, there will be a little difference
between how the form looks online and how it looks when printed. You will want to design the
online view of your e-form to be easy for the users to navigate and complete while ensuring the
hard copy view is well organized and easy to read. This process usually involves some trial and
error and manipulating of the data fields to achieve the best results for both views.
After you design your e-form, you should present this design to the key users and
communication partners who will be using the form. This allows them to get involved in the
design process and provide feedback, all of which creates “buy in.” People are much more apt
to use forms and processes if they have a part in the planning and implementation. Once you
have presented the form to the others and they approve it, you can prepare to implement the eform during the next phase.
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To Design Your E-Form:
1. Using your notes gathered from the requirements analysis, decide what data you need to
collect, transmit, or store with your e-form.
a. List all of the fields you wish to include on your e-form.
b. If possible, group related fields into data sections. For example, the patient's name,
date of birth, Social Security number, address, and other data related to the patient's
demographics could be grouped into a data section called “Patient Information.”
c. Using the table on page 23, determine what kind of data will be appropriate for each
field (e.g., text, number, yes/no, drop-down box with choices, etc.). This will help you
determine what data types to use to help your users quickly enter data into the form.
d. Decide which fields will be required (i.e., where data entry is required) so that all the
users and communication partners get the information they will need.

2. Draw a sketch of your new form or use an existing paper form for a guide.
3. Ask everyone who will use the e-form to review your design and provide feedback.
4. If feasible, incorporate the suggested changes into your e-form's design.
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5. Present the design changes and ask for feedback as often as necessary until everyone
involved is satisfied with the form's design.

Implementation Phase
After you have finished designing the form, you can access the Facility Administrator console
and start “programming” the e-form. When you finish the e-form, you will want to link it to one or
two work lists (see “Managing E-Forms For Your Work Lists”) so that a small group of users can
put the e-form through a rigorous routine of testing and error detection. Such tests include
looking for correct spelling, incorrect field auto-population, layout problems with the online or
printed versions, missing fields, correct options in drop-down lists, and other errors. Depending
on how much time you spent in the design phase, you could spend a lot of time making
corrections. Once the users who are testing the e-form are happy with its design and use, you
can release it to the rest of the users by attaching the e-form to each work list that will need to
access it. After you have fully tested and implemented the form, you are ready for the next
phase.
When you implement an e-form, you may want to save a PDF version of the form to
refer to as a backup in case the e-form is accidentally deleted or modified. Be sure to do
this every time you make changes to the e-form.

Maintenance Phase
Once you have launched the e-form and people are using it, you will want to periodically review
the form and keep it up to date. At this point, you may also choose to write and maintain
accurate documentation about the e-form. Documentation gives the form's users something to
consult when you are not there, and also serves as a reference guide for you to use when
planning changes or additions. The documentation should include the form's purpose, target
audience, samples, resources, and general information. It should also include design notes, and
samples and layout specifications you made in the first and second phases.
Throughout the course of the form's existence, you will probably be asked to change and make
additions to it as it evolves. Make sure to record any changes or additions to the form in the
documentation just in case someone else must maintain it. Also keep up to date backups--it
always pays to be prepared.

E-Form Tutorial: A Basic Transportation Request Form
This tutorial will teach you to create a simple form for requesting transportation for a patient.
Certain hospitals may complete forms like this one to request a shuttle, taxi, or ambulance to
transfer a patient out of the hospital to another facility and then fax the form to the transportation
companies.
For the purposes of this tutorial, we will assume you and your hospital users currently complete
a paper transportation request form and then fax it to the respective transportation companies to
complete the request. Because you want to streamline the request process and take advantage
of the communications reliability with ProviderLink, you decide that the transportation request
form would work very well as an e-form. The tutorial will follow the development life cycle as
described in the previous section.
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ON YOUR OWN - For the purposes of the tutorial, this is the “On Your Own” icon. You
will see this icon when there are portions of the e-form you are to complete without stepby-step instructions. This is usually to create fields similar to those previously created
with the help of the tutorial, and the “On Your Own” message will provide all the
information you need to successfully complete the task.

Requirements Analysis And Definitions Phase
After you meet with the social workers who will complete and send the request form and the
representatives from the transportation companies that receive the forms, you compile the
following list of requirements:
•

The Transportation Request Form will be owned and maintained by the hospital.

•

The form is completed when one of the hospital's social workers needs to request
transportation from the hospital on behalf of a patient upon discharge.

•

Once the form is complete, the social worker will send the form through a ProviderLink
message to the fax machine of the hospital's shuttle van service, a taxi company, or the
ambulance service.

•

The respective transportation service representatives will acknowledge the receipt of the
request, schedule the transfer, and reply to the message using the ProviderLink fax-back
cover page.

•

The original form and the reply will be electronically stored with the ProviderLink patient
record and a copy can be printed, if necessary, when the driver arrives to pick up the
patient.

•

The transportation service providers agreed upon the following list of data they would
require to be able to schedule the transport:
- date of the request

- patient demographic info

- insurance policy info

- date and time of transport

- facility to receive the patient

- employer point of contact

- patient or hospital pays

- point of contact at receiving
facility

•

If the patient requires ambulance service, the social worker needs to include additional
supporting information to justify the need for an ambulance.

•

The form needs to be signed by the social worker for the request to be valid.
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Design Phase
After you work through several turns of producing drafts, soliciting feedback from the users and
transportation service providers, and making changes to the form's design, you all agree on the
design as depicted in the drawing on below. You are now ready to begin creating the e-form.
Form
Diagram

You will need to refer back to this diagram periodically to complete the tutorial that follows over
the next several pages.

Implementation Phase
Creating The New E-Form
With everything you have learned from the previous two phases in your e-form's development,
you are ready to begin the actual “programming” of your form. We will begin by creating a new
instance of the form.
To Create A New E-Form Instance:
1. From the Main Window menu bar, click Setup. The Facility Administrator console
appears.
2. From the menu bar, click Customizations
forms for your facility appears.

Created E-Forms. The list of created

3. From the menu bar, click New
E-Form. A blank E-Form Template Properties screen
appears (i.e., new instance of the e-form).
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4. In the E-form Template Properties section at the top of the screen, type Transport
Request in the Name field. The Name field is limited to 20 characters.
5. For the Description, type Patient Transportation Request Form. The
description may be the same as the form's name.
6. You will need to complete at least the First Line field in the form's Heading Area section.
Enter Transportation Request Form in the First Line field.
7. To save this e-form, click the Save button. You will return to the Created Forms screen
with your new form added to the list.

You will want to save your e-form after every stage of its development, and
periodically throughout the development process. It is frighteningly easy to lose any
unsaved work by clicking in the wrong place (e.g., in the breadcrumb trail) when creating
an e-form with the Forms Designer. Saving frequently will prevent losing large portions
of development and time.

Creating The Data Fields For The E-Form
Now that we have created the instance of the e-form, we are ready to begin creating the data
fields. We will create the fields in the order they will appear on the e-form, starting with the Date
field.
To Create The Data Fields For The Transportation Request E-Form:
1. From the Created Forms List screen, click the Transport Request form name link. The
E-Form Template Properties screen appears.
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2. In the Fields section, click the Define Fields button. The Field List screen appears.
3. Click the New Field button to bring up the Field Specification screen where you will
define your new field.

4. In the Field Label field, enter the label you wish to see displayed on the form. The label
should be reasonably descriptive as to what type of information the user should enter
into that space on the form. You can also select specific text formatting for this label,
such as the Font size, as well as being bold, italicized, or underlined. For this field, enter
Date for the Field Label.
It helps to determine the order in which you will create the fields. In the Field List, the
fields will appear in the order in which you created them. You may choose to enter fields
in the order in which they will appear on the form, or you may enter them in alphabetical
order (you will need to determine the alphabetical order manually). The most commonly
used and recommended method is to create the fields in the order in which they will
appear on the form. This way, the fields will be much easier to find and place in the Data
Sections as explained later in the tutorial.

5. From the field Type drop-down box, choose Date. The additional field properties for the
date data type appear.
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6. With a date data type, you have the option of giving the users a Date Pop-up Tool; a
pop-up calendar to help users enter the date into the field. Click the check box to turn
on the tool.
7. Currently, there is no option to have the current date auto populated into a field, so we
will not choose to turn on the Autopopulated? Option.
8. Based on our notes from the planning meetings, the Date field needs to be a required
field. Choosing to require data entry in a field will mark the field with a red asterisk,
signaling to the user that data entry is required.
a. Click the Required? checkbox to turn on the option.
b. You have the ability to customize the error message that appears if the user tries to
check the form or send the form without completing the required fields. In this case,
enter You must enter the date the request is made.
9. You may also create on-screen help to assist the users in knowing what to enter into the
field. This screen tip will appear when the user hovers the mouse cursor over the field
label. While screen tips are not necessary for every field you create, they can be useful
for more confusing fields where there are questions about what to enter. View the image
above for an example of help text to display.
10. When you are finished creating the field and modifying the field properties, click the
Save button to save your field and return to the Field List. You will see your new field
added to the list.

11. If you need to modify the field properties, you may either click the Edit button or the field
Name link to re-enter the Field Specifications screen and make your changes. Be sure
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to click the Save button to save any changes you make, or click the Cancel button to
exit the screen and return to the Field List.
ON YOUR OWN – Using the same techniques as the Date field, create the Date of
Transport field as depicted in the form diagram on page Error! Bookmark not defined..

Creating Text Fields
Next, we will create the Time Requested field and use the Text data field type. A Text field will
accept virtually any type of text to include letters, numbers, spaces, and special characters. You
may designate the Text field's width in characters up to 64 characters.
In the ProviderLink Forms Designer, the maximum width in characters for text and text
area fields is 64, provided you will be placing those fields in a data section with a onecolumn layout. If you use any of the two-column layouts, the maximum width in
characters must be reduced for the field to fit into the data section.
Use the following as a guideline for setting the maximum width in characters for text and
text area fields when placing them in data sections with the various layouts:
Layout - Max Width in Characters
• One column
64 characters
• Two Equal Width columns
32 characters for each column
• Three Equal Width columns
21 characters for each column
• Wide/Narrow
Left - 48 characters
Right – 16 characters
• Narrow/Wide
Left – 16 characters
Right – 48 characters
• Narrow / Medium / narrow
Left – 16 characters
Middle – 36 characters
Right – 16 characters

To Create A Text Field:
1. From the Field List screen, click the New Field button. The Field Specification screen
appears.
2. For the Field Label, enter Time Requested.
3. Choose Text from the Type drop-down list. The Text field properties appear.
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4. You may choose Alphanumeric from the Format drop-down list though, if you do not
specify a format, Alphanumeric is the default.
5. The Width in Characters defaults to 20. You may choose to reduce this to 10 if you
wish.
6. Click the Required? check box to make data entry in this field mandatory.
7. You may wish to enter the Help Text as shown in the image above to help the users
properly enter the time of the request.
8. Click the Save button to save the field and add it to the Field List.
Creating Yes/No Fields
For our e-form, the user must designate who is going to pay for the transport: the patient, the
hospital, or both. To accomplish this, we decided to use Yes/No fields to indicate which party or
parties will be paying. We can also use a Yes/No field to indicate whether or not the patient
needs to be transported by ambulance.
To Create A Yes/No Field:
1. From the Field List screen, click the New Field button. The Field Specification screen
appears.
2. For the Field Label, enter Patient Pay?.
3. Choose Yes/No from the Type drop-down list. The Yes/No field properties appear.
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4. You may choose to make the field Required and enter Help Text as desired.
5. Click the Save button to save the field.
ON YOUR OWN – Using the same techniques as the Patient Pay? field, create the
Hospital Pay? and Need Ambulance? fields as depicted in the form diagram on page
Error! Bookmark not defined.. Choose No as the Default Value for the Hospital Pay?
field.

Creating Select From List (Drop-Down) Fields
Many times if there is a short list of possible values a user may enter into a particular field, you
can aid in data entry by creating a drop-down or select list for the user to choose the value. The
Forms Designer makes creating a drop-down list easy for helping our users choose what type of
facility the patient is being transported.
To Create A Select From List (Drop-Down) Field:
1. From the Field List screen, click the New Field button. The Field Specification screen
appears.
2. For the Field Label, enter Transfer To:.
3. Choose Select From List (Drop-Down) from the Type drop-down list. The Select From
List field properties appear.
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4. In the Enter the choices below: list box, enter the values that will appear in the dropdown list.
a. Type SNF and press Enter (i.e., on the keyboard) to go to the next line.
b. Type Home and press Enter.
c. Type Other Hospital and press Enter.
d. Type Other.
5. Since most patients will be transported to skilled nursing facilities, we want to choose
SNF as the default value. Click the check box in front of (Check to select first value as
default).
6. You may choose to make this field required but, since a value will be chosen by default,
there will always be a value that fulfills the requirement. However, choosing the Required
option will add the red asterisk to the form as a reminder to the user to enter the receiving
facility type.
7. Click Save to save the field and add it to the Field List.
ON YOUR OWN – Create the Name of Facility and Address text fields as depicted in the
form diagram on page Error! Bookmark not defined.. Enter field widths of 32
characters for both fields, and make the Address field required for data entry.

Using Text Field Formats
Along with using text fields to enter free form text, you may choose one of the formats to ensure
your users enter the correct data in the fields. Some of the formats you may choose include
Social Security number, US phone number, letters only, and numbers only to name a few. We
will use the US phone number format to guide the users in entering telephone numbers on our
e-form.
To Use A Text Field Format:
1. From the Field List screen, click the New Field button. The Field Specification screen
appears.
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2. For the Field Label, enter Phone:.
3. Choose Text from the Type drop-down list. The Text field properties appear.

4. From the Format drop-down list, choose US Telephone No.
5. Change the Width in Characters to 15.
6. Make the field Required.
7. Click Save to save the field and return to the Field List.
ON YOUR OWN – Create the Room Number and Person To Contact text fields as
depicted in the form diagram on page Error! Bookmark not defined.. Leave the default
Width in Characters for both fields, and make the Person To Contact field required for
data entry.

8. When you have finished creating the fields listed above, at this point it is a good idea to
close the field list and save the progress you have made on your form.
a. From the Field List, click the Close List button to return to the E-Form Template
Properties screen.
b. Click Save to save your form and return to the Created Forms screen.
c. To re-enter the form, click the Transport Request form name link.
Using The Auto Populate Option With Text And Date Fields
To help save time entering data, you can choose to have certain form field automatically filled
in, or auto populated, using data from the patient record, facility properties (i.e., for your facility),
or user account. You may choose to auto populate either text fields or date fields. Currently, the
only data you may use to auto populate a date field is the patient's date of birth.
To Auto Populate A Text Field With Patient Data:
1. In the Fields section on the E-Form Template Properties screen, click the Define Fields
button. The Field List screen appears.
2. Click either New Field button to bring up the Field Specification screen where you will
define your new field.
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3. For the Field Label, enter Name:.
4. Choose Text from the Type drop-down list. The Text field properties appear.

5. Expand the Width in Characters to 32 characters.
6. Auto populate the field with the patient's full name.
a. Click the Auto populated? check box to turn on the option.
b. From the corresponding drop-down list, choose Patient Full Name. Notice the other
choices you may use to auto populate text fields.
7. You may choose to make this field Required though, since this field will be auto
populated with the patient's name, the field will always contain data which will fulfill the
data entry requirement.
8. Click Save to save the field and add it to the Field List.
To Auto Populate A Date Field With The Patient's Date Of Birth:
1. Click the New Field button to bring up the Field Specification screen where you will
define your new field.
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2. For the Field Label, enter Date Of Birth:.
3. Choose Date from the Type drop-down list. The Date field properties appear.
4. You may choose to include the Date pop-up tool with the date field though, since the
date will be auto populated from the patient record, this is not necessary.
5. Autopopulate the field with the patient's date of birth.
a. Click the Autopopulated? check box to turn on the option.
b. From the corresponding drop-down list, choose Patient DOB (i.e., abbreviation for
Date Of Birth).
6. You may choose to make this field Required though, since this field will be auto
populated with the patient's date of birth, the field will always contain data which will fulfill
the data entry requirement.
7. Click Save to save the field and add it to the Field List.
ON YOUR OWN – Using the same techniques as the patient's Name field, create the
Address, City, ST, ZIP, and Social Security No. fields (i.e., using the respective auto
populate options) as depicted in the form diagram on page Error! Bookmark not
defined.. Make all of the field widths 32 characters and require data entry as desired.
You may reuse the Phone field you created previously, so you will not need to create
another field for the patient's Phone field.
Then, you will be ready to create the text fields for the Insurance Provider, Policy No.,
Group No., Employer, and Employer Phone fields. Expand the field width for the
Insurance Provider and Employer fields to 32 characters, and use the US Telephone No.
format for the Employer Phone field.

Creating Check Box Fields
Check boxes are used when you want to let the users choose from a set of options instead of
only one like they would with a drop-down list or radio button group. We will use check boxes in
the bottom portion of our form to help justify why a patient would need to use transportation by
ambulance.
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To Use A Check Box:
1. Click the New Field button to bring up the Field Specification screen where you will
define your new field.
2. For the Field Label, enter Patient Unable To Sit:.
3. Choose Check box from the Type drop-down list. The Check box field properties appear.

4. In this case, we will not make this check box Required.
5. Click Save to save the field and add it to the Field List.
ON YOUR OWN – Using the same techniques as the Patient Unable To Sit field, create
the check boxes for the other four fields (Patient Requires Oxygen, Patient Requires
Suctioning, Patient Requires Life Support, and Patient Requires IV) as depicted in the
form diagram on page Error! Bookmark not defined.. None of the fields needs to be
required for data entry.
Then, create one last text field for the field labeled Other. Make the field 32 characters
wide.

Creating Textarea Fields
Textarea fields are multi-line, input text fields that allows users to add more information than the
normal text fields will allow. This is useful when you want users to enter long answers to
questions, or provide more details. There is a field in the Ambulance section of our e-form for
which a text area field will be useful.
Textarea fields are similar to text fields in that you may designate the width in characters. You
may also choose how many lines of text will appear in the text area field before the text begins
to scroll.
To Create A Textarea Field:
1. Click the New Field button to bring up the Field Specification screen where you will
define your new field.
2. For the Field Label, enter Describe Diagnoses Which Contribute:.
3. Choose Textarea from the Type drop-down list. The Textarea field properties appear.

40

E-Forms Designer Techniques

4. Set the Width in Characters to 32.
5. Set the Number of Lines to 4. This will allow 4 lines of 32 characters to be visible before
the text area field begins scrolling.
6. Click Save to save the text area field and add it to the Field List.
7. You are finished creating fields for this e-form, so you may click the Close List button to
return to the E-Form Template Properties screen.
8. Click Save to save your progress on the e-form.
9. Click Transport Request to re-enter the form.

Working With Data Sections
Now that we have created all of the fields we will need for entering data into our e-form, we are
ready to create the data sections and choose the layouts for setting up our form. For each data
section, you will enter a name that will be displayed at the top of the data section and choose a
column layout.
After you have chosen the layout, you will select the fields from drop-down lists to place them in
the data section. Each field may only be used once in each data section however, like the
phone field we created earlier, we can use a field in more than one data section.
You may also use some basic logic to determine whether or not a data section will be visible
based on the value in one of the form's Yes/No, Select From List, or Check box fields. For
example, in our scenario we would not need to complete the ambulance data section unless the
patient needed to be transported by ambulance. So, we will choose to have the ambulance data
section appear only when the Need Ambulance? field value is “Yes.”
To Set Up The Transfer Information Data Section:
1. From the E-Form Template Properties screen for your e-form, click the Add button under
Data Sections. The Data Section Specification screen appears.
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2. In the Data Section Name field, enter Transportation Information.
3. Click the option for Two Equal Width columns in the Column Layout section. An
additional column is added to the Field List section.

4. In the Field List section, click the Add button in both the left and the right columns until
there are six field drop-down lists in each column in which to place fields.
5. Using the diagram on page 31, use the Field drop-down lists to select the fields to place
in each location. When you are finished, your Field List should match the one below.

6. When you are finished placing fields, click Save to save the data section and return to the
E-Form Template Properties screen. Your newly completed data section will be visible.
a. If you need to change the layout of the data section, you may click the Edit button to
open the data section. Keep in mind you are only changing the layout of the data

42

E-Forms Designer Techniques
section. If you need to edit one of the fields, you will need to enter the Field List as
described above on page 32 .
X

b. If you wish to remove the data section completely, click the Delete button. This will
remove the data section but not the fields themselves.

ON YOUR OWN – Using the same techniques you learned above, create the Patient
Information data section as depicted in the form diagram on page 31. Use the Two Equal
Width column layout. When you finish, your data section should look like the one below:

To Create The Data-dependent Ambulance Data Section:
1. From the E-Form Template Properties screen for your e-form, click the Add button under
Data Sections. The Data Section Specification screen appears.
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2. In the Data Section Name field, enter Ambulance

Necessary

For

The

Following Reasons:
3. In the Depends On drop-down list, choose Need Ambulance? And, when the value
drop-down list appears, be sure Yes is selected.
4. Click the option for Two Equal Width columns in the Column Layout section. An
additional column is added to the Field List section.
5. Using the same techniques you learned above, place the fields in the Ambulance data
section as depicted in the form diagram. When you finish placing the fields, your data
section should look like the one pictured:

6. When you are finished creating your data sections, be sure to save your progress on the
e-form.

Setting Up Signatures Areas
The Forms Designer allows you to create signature areas that will appear at the bottom of your
e-form. You may configure signature areas to match your user's signature workflows You may
choose to for your e-forms to feature a signature blank for a handwritten signature or auto
populate the signature field with a user name or electronic signature.
If your facility supports electronic signatures, you may make the signature process easy for your
users by adding an electronic signature area to your form. The electronic signature option
allows any user to electronically sign the form by entering his or her user name and password.
We will use the electronic signature option to fulfill our requirement for the social worker's
signature to be included at the bottom of our transportation request form.
To Create A Signature Area:
1. From the E-Form Template Properties screen for your e-form, click the Add button under
Signature Areas. The Signature Area Specification screen appears.
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2. In the Signature Field Label field, enter Social Worker.
3. To add a date field to indicate the date the form is signed, click the check box to the right
of Date Field?.
4. To give the user the ability to electronically sign the e-form, click the Auto populate? drop-

down box and choose Electronic Signature.
5. To save your electronic signature area with the e-form, click the Save button. You will
return to the E-Form Template Properties screen, which will include your new signature
area.
6. Be sure to click Save to save your progress on the e-form.

Previewing Your E-Form
As you are developing your e-form, you may want to periodically preview what your form will
look like when the users will complete it as well as how it will look when it is printed or faxed.
The Forms Designer features the ability to preview your form online or as a PDF document. This
allows you to see the effects your data section layouts have on your entire form, especially the
printed output.
Previewing the form online also allows you to test the functionality of the form in a test
environment. You can check for spelling errors, see if your drop-down fields have all the correct
values, test your data-dependent data sections, and all other features on your form. Most of the
errors or other “bugs” that may appear in your form can usually be identified and fixed by
previewing the form before you publish it.
To View The Online And Print Previews Of An E-Form:
1. From the E-Form Template Properties screen for your e-form, click the Preview Form
button in the Preview Form section. The online version of your form appears, but without
the data that would be auto populated from the patient record.
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2. Check each of the fields in your form to make sure it has the required functionality:
a. Ensure date fields include the date pop-up tool and that the tools work as expected.
b. Open your drop-down lists to make sure all of the values are present and that the
correct values are set to default.
c. Look to see if your Yes/No fields have the correct values set to default.
d. Check to see if the correct fields are required for data entry.
e. Check to make sure your data-dependent data sections appear when the correct value
is chosen. In this form, change the Need Ambulance? value to Yes to reveal the
Ambulance Necessary section.
3. When you have finished previewing your form online and testing its functionality, you may
return to the E-Form Template Properties screen by clicking the Close Preview button at
the bottom of the form.
4. To view how your form will look when printed or when a communication partner receives
it on their fax machine, click the Preview PDF button.
a. The system will convert the e-form to a PDF document which will be read by your PDF
viewer.
b. For most operating systems, you will need to choose to open your PDF viewer when
the following dialog box appears:
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c. Click the Open button to open your form in your PDF viewer.
d. Check your form to see if the printed layout is acceptable. Look particularly at where
the page breaks fall, if applicable.
e. You may print the form using the print function of your PDF viewer. This is useful if you
should need to show your users or communication partners what the printed form will
look like when they receive it via fax.

f. When you are finished viewing the PDF version of your form, you may close your PDF
viewer to return to the E-Forms Template Properties screen in ProviderLink.
5. If you need to make adjustments to your form, use the instructions above to modify the
fields, data sections, or signature areas and preview the form both online and PDF again
to review your changes.
6. Be sure to save the form when you are finished previewing it.
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Activating The E-Form And Attaching It To Work Lists For Testing
When you have previewed and tested the form as thoroughly as the form preview will allow, you
can activate the form and attach it to a sample of work lists for you and your users to test the
form further. Only by attaching the e-form to a work list and generating it through a patient
record will you be able to see if all of the form's features, including field auto population, work as
expected.
To Activate An E-Form:
1. From the Created Forms list, find the e-form you wish to activate.
2. Click the Activate button to take your form out of edit mode and activate it for use.

3. When you need to make changes to the form, you will need to click the Deactivate button
to deactivate the form and edit it.
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You need to activate an e-form for the users to be able to complete and send it. When
you deactivate the e-form, users will not be able to create new instances of the form until
you reactivate it. However, they will be able to access and work with previously created
instances of the form.

Be sure to have users who are experienced with ProviderLink e-forms test your form's design
and functionality. Use the instructions outlined in “Managing E-Forms For Your Work Lists” on
page 7 to add your e-form to the appropriate work lists. Then, view a work list the e-form is
attached to, access a patient record, and open your new e-form. Test all of the form's
functionality and be sure the fields you choose to auto populate are working as expected.

Maintenance Phase
Periodically evaluate your e-form to make sure it fulfills the requirements as agreed upon during
the earlier phases. If necessary, you can write a short guide for your e-form's instructions and
use and distribute it to your users and their communication partners.
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Summary
You should now be able to take what you have learned through this tutorial and apply it as you
create virtually any e-form you may need. You created an e-form instance, built the fields and
data sections that made up the form, placed the fields in the data sections, tested the form, and
implemented it for use.
You should continue to experiment with the Forms Designer and the e-form you have created.
What other forms or processes might you be able to create and use an e-form?
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